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Introduction
Power*Log™(Petrographical Office Wellsite Evaluation and Reporting) is a chip and core logging management
program that utilizes single-entry data capturing to produce geological striplogs. The geological data is entered into
the system through the use of intuitive data entry forms to ensure standardization of data. This data is stored in an
RDBMS(Relational Database Management System) to allow data manipulation using SQL access tools.
Power*Log™ software consists of four (4) main parts:
1.)
2.)
3.)
4.)

A log editor module that allows you to change the striplogs to suit your needs and preferences.
A data transfer module.
Report printing modules.
An on-line help system that is designed to familiarize you with the commands and functions available in
Power*Log™ and lead you through many of the processes involved in creating welllogs.

A note about navigating through Power*Log™ Reports:
When you are entering information into data forms, you may move between boxes/fields by pressing the Tab key
to go forward and Shift +Tab keys to move backwards. To exit forms that do not have an Exit, OK, or Cancel
button, press the Esc key on the keyboard.
To access the On-line Help System in Power*Log™:
You can make use of the context sensitive help by pressing the F1 key when you are in a dialogue box. A pertinent
help file will appear, opened to the topic relevant to the dialogue box you are in.
Below are some examples of common features within Power*Log™:
The Toolbar

The Selection Bar…

Selection Bar Using the Default American Style Inches Screen Scale

Selection Bar Using the Ratio Style Selection for Screen Scale
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The Status Bar…
The Status Bar displays system status messages and any error message (associated with a field entry), in the far
left corner. The KB elevation is displayed in the lower right corner of the Status Bar.
The Import Toolbar
This toolbar is dock able and can be moved to different places on the screen.
The Power*Log / Core & Curve™ Import Toolbar…

The Export Toolbar
This toolbar is dock able and can be moved to different places on the screen.
The Power*Log / Core & Curve™ Export Toolbar…

Button, Check box and drop box types.

The Four (4) Main On-line Help System Categories:
Commands - Descriptions of each menu command within Power*Log / Core & Curve™.
Toolbar - Shortcuts to common commands are explained.
Database Table Operations - Commands or functions related to the Database Table are described.
Quick Reference Guide - The portion of the On-line Help System that quickly refers you to some of the more
commonly performed tasks
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This tutorial will guide you through the process of creating and editing a new striplog (hereafter referred to
simply as a log), with curves and interpreted lithology.
Connecting to the Database

1.) Double click on the Power*Log
the

Icon. Acknowledge the Security Information window by clicking on

button. This will initiate the program and activate a Connect Database window.

2.) Highlight the PGEOLOGY 2016 IMPERIAL (Microsoft Access Driver[*.mbd]) database by clicking on it
once.
3.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field.
Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field.
4.) Type “pgeology” in the Password field and then click on the
load various dictionaries and then activate an Open Log window.

button. The program will now

Creating a new Well / Log
The first step in creating a new log is to click on the
New Log button on the Toolbar or to select New under
File on the Selection Bar. This will open the New Log window on the next page.
This more than likely will appear after connecting to the Database without you have to do the above procedure if
this was the first time you have activated Power*Log.

1.) The Well/Log Name field is where you enter the name of the well (no more than 50 characters long). Type
“Tutorial Well” into the Well / Log Name field.
2.) Click on the

button to activate the UWI Format window.

Imperial Tutorial Page 6

2016

Power*Log Imperial Tutorial

4.) The default or flashing caret is in the API Code / Name field. Type in “35-139-23155”. The 23 is a State Code,
the 139 is a County Code, the 20130 is the Unique Well ID.
button when you have finished entering the API Code. You will notice that the API
5.) Click on the
/ UWI field will be filled in the New Log window.
6.) Click on the

button to activate the Log Format List window.

6.) Click on “V SYSTEM Geology Log [SYSTEM (I)]” to highlight it and then click on the
You may also double click on “V SYSTEM Geology Log [SYSTEM (I)].”

button.

7.) Once you have been returned to the New Log window, double click in the Log Start Depth field. This will
highlight the zero (0) and activate a flashing cursor. Type 6000 in the Log Start Depth field.
8.) Once the information is entered, click on the

button.

9.) This will initiate a New Log. During this process, the curves associated with the selected log format will be
added. Drill Rate will be the first Add curve window.
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10.) Select min/2ft from the Curve Units drop down box. If done correctly it will look like Figure below.

11.) Click on the
button in the Add Curve window for Drill Rate. This will activate the second Add
Curve window for Total Gas shown below.

12.) Click on the
layout


button in the Add Curve window for Total Gas. This will activate well and it’s log

You have just added two curves to the database that will be displayed as curve layers in the Drilling
Progress track on the new Tutorial log showing the Tutorial Wells information.
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**When the log opens, it should resemble this log.**
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1.) You can now fill in your pertinent well information by selecting Well under Edit pull down menu on the
Selection Bar to activate the Well window.

2.) Fill in the information you feel is necessary (The well window shown above has been filled in to give you an
button to save any changes you have made to
idea of how to complete the fields) and then click on the
the database.
Note: Some of the fields in the Edit Well window have character restrictions or mandatory requirements.
Consequently, if any of these restrictions have been violated or if any requirements have not been met, the
offending field will be highlighted. The nature of the problem will be displayed on the Status Bar (lower left corner of
the screen), and you will be prompted with a system error message window.
3.) If the record has been successfully saved, click on the
Options system window.

Imperial Tutorial Page 10

button, when prompted with the Shortcut

2016

Power*Log Imperial Tutorial

The System Options Window
To activate the System Options window click on System Options under the Options menu selection.
General Tab

Home Directory - This is the directory on your hard drive where Power*Log, Power*Core and Power*Curve is
being executed. The user will not see any symbols on their log or print out any of our reports it you have the wrong
home directory.
This check box when
activated will populate the Open Log window with all the wells in
the database. If it is unchecked it may help our corporate users and the time it take to retrieve thousands of wells
from the database and to populate the Open Log window with that information. If this check box is deactivated and
you wish to see all your wells then simply click on the
their wells if this option is deactivated.

button in the Open Log window to see all

Date Format - From this drop box, you can select the date format. This selection
determines how every date in Power*Log / Core & Curve will be entered and displayed.
If you import a log with different date formats, Power*Log / Core & Curve will change
the dates to comply with the format you've chosen here. The user can change this at any
time and all the Date formats will be changed in the database.
Version Compatibility - Enables the user to achieve compatibility for Annotations in the
older Versions of Power*Suite (V1.81 and before) and the Annotations in the newer
Versions of Power*Suite (V1.9 and later).
Data Buffer Lookahead - The number placed in this field determines how far ahead and behind the current top
depth will be stored in the computers buffer. The larger the look ahead number, the longer it takes for Power*Log /
Core & Curve to refresh the screen when you exceed the look ahead value. However, until you meet or exceed the
look ahead value, scrolling will be much faster, because the database is not yet being accessed.
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Fonts Tab
This tab allows the user to set up most of the fonts used in Power*Log, Core and Curve. You can set it up
to be used on the current log as well as using the fonts as your defaults when you are making new logs.

Annotation Font - Allows you to determine the default font style, type, color and size of your annotations on your
log, Also this is the default when you use any of the Sample Description Transfer options.
Survey Font - Allows you to determine the font style, type, color and size of your survey data associated with the
Survey Layer on your log.
Bit Record Font - Allows you to determine the font style, type, color and size of your bit record data associated
with the Bit Record Layer on your log.
Generic Category Font - Allows you to determine the font style, type, color and size of your Long or Short Name
display option in all the Generic Category Layers displayed on your log.
Depth Font - This allows you to determine the font style, type, color and size of the depth markers in the Depth
track of the log.

- These radio buttons allows the user to change the orientation of the
Depth Font on the Layer. Beware you may have to change the Track Width to accommodate the Font
size and orientation. Refer to the Log Configuration Builder to do this.
This check box
when activated will display the depth units with the depth on the
Depth Layer. ie. 1000 ft or 1000 m vs. 1000
Track Header Font - Allows you to determine the font style, type, color and size of your Track Headers on your log.
All track headers use the same font across the entire log.
Layer Header Font - Allows you to determine the font style, type, color and size of your Layer Headers on your log.
All Layer headers use the same font across the entire log.
Formation Tops Font - Allows you to determine the font style, type, color and size of your Formation Tops data
associated with the Formation Tops Long and Expanded Layers on your log.
Offscale Font - Allows you to determine the font style, type, color and size of your curve values displayed when the
curve pegs off scale.
Core Box Font - Allows you to determine the font style, type, color and size of your Core Box data entered in the
Core Box layer.
Casing String Font - Allows you to determine the font style, type, color and size of your Casing string data
displayed on the Casing String layer. This data is entered through the Casing String Report.
Date Font - Allows you to determine the font style, type, color and size of your Date data entered in the Date layer.
Core Sample Code Font - Allows you to determine the font style, type, color and size of your Core Plug data
entered through the Core Plug Report. This font is displayed on the Core Sample Code layer.
Sidewall Core Font - Allows you to determine the font style, type, color and size of your Sidewall Run and Sample
Number data entered through the Sidewall Core Report. This font is displayed on the Sidewall Core layer.
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MDT Font - Allows you to determine the font style, type, color and size of your MDT Run and Test Number data
entered through the MDT Report. This font is displayed on the MDT layer.

This check box
when activated will make the font setting in this window your
defaults for any new log created regardless on the Fonts stored in the template.
Display Tab

Arrowed Subintervals - This check box
when activated will indicate the top and bottom of your subintervals
(portion of an interval) with an arrow rather than a set of symbols. An example is shown below.

Normal Subintervals
Arrowed Subintervals
when activated, this function makes the background of the accessory symbols
Transparent - This check box
transparent, so that the bed in the background shows through. If deactivated, a white background surrounds the
accessory symbols in order to separate them more from the beds.
Use Global Symbols – With the ability to edit existing metafiles the user may have imported a well that has used
metafiles or symbols that have been modified to look differently than the one existing within your system symbols. If
you wish to use your symbol set instead of the revised imported ones you can select this check box
to make that
change.
when activated will display the interbed data with a line display
Interbed Line Display Type - This check box
splitting the two lithology types or when unchecked will display the lithology in an interbed fashion as displayed
below.
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Curve Backup fill – This check box
when activated will show a sideways hatching fill pattern when a curve goes
off scale or in the backup mode. If unchecked there will be no hatching pattern when the curve goes off scale.
Frequency @ 1:240 – This drop box determines how often symbols are drawn on a Lithology Layer, with the
scale of 1:240. For example: 1 symbol every 1 meter at 1:240, 2 symbols every 1 meter at 1:120, 1 symbol every 2
meters at 1:480, and so on. These frequencies are only in effect if you utilize the entire interval in Oil Shows,
Rounding, Sorting, Framework, or designated an interval in Sedimentary Structures, Traces Fossils and Rock
Accessories.
Lithology Profile - This check box
when activated will fill in the Carbonate Texture and Grain Size layers with
the interpretive lithology. It will draw the lithology to the maximum size filled in over the interval.
Note: The user may wish to turn off the track borders when this option is selected. You will see an example of this
shown below.

Use Ratio Scales: This option allows the Imperial Users to utilize a ratio 1:200 or 1:500 rather than 2” or 5” which
would be standard selections in the United States.
Grain Size Scale List box - You may choose between Wentworth, Canstrat or Amstrat
scales, when using the Grain Size Builder. The Wentworth Grain size only allows full grain
size while Canstrat / Amstrat allow half grain sizes when drafting in the Grain size and matrix
layers.
This
radio button will display the Grain Size Track header with the equivalent verbal grain
sizes such as such as C slt, VF snd, F snd, M snd, C snd etc.

Verbal Scale

MM Scale

This
radio button will display the Grain Size Track header with the equivalent numeric grain
sizes (in mm) such as .0625, .125, .25, .5, 1, 2 etc. as shown above.
This
radio button will display the grain size with strait edges and right angles between the grain
sizes. The illustration below is shown with Lithology Profile activated.

Hard Edges
This

Soft Edges

radio button will display the grain size with curved edges and rounded angles between the

grain sizes.
This drop box allows the user to select a hatching
Grain Size
pattern when using the Grain Size Layer with the Lithology Profile not activate.
This color selector allows the user to pick the line color (foreground) when the fill
Grain Size
pattern option is used. The background color is found in the Layer configuration for the Grain Size.

Grain Size No Pattern Hard edges
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Carbonate Texture
This drop box allows the user to select a
hatching pattern when using the Carbonate Texture Layer with the Lithology Profile not activate.
This color selector allows the user to pick the line color (foreground) when
Carbonate Texture
the fill pattern option is used. The background color is found in the Layer configuration for the Carbonate Texture
Layer.
Carbonate Textures
This
radio button will display the grain size with strait edges and right angles
between the Carbonate Textures. The illustration below is shown with Lithology Profile activated.
Carbonate Textures
This
angles between the Carbonate Textures.

radio button will display the grain size with curved edges and rounded

-When this check box
is activated the bedding contacts
(lines) between the drawn lithology types in the Interpretive Lithology Layer will be shown.
When this check box
is activated it will turn on the accessories in
the Interpretive Lithology Layer.
Monitor Height - This option allows you to scale your monitor for Power*Log / Core so you may correlate onscreen wells with hard copy logs that you may have. It is recommended that you take an opportunity to measure the
vertical viewing area of your monitor in inches and then insert that value in the Monitor Height field. Be aware,
however, that if you adjust the screen height knob on your monitor, this will affect the monitor height setting.
Monitor Width - This option allows you to scale your monitor for Power*Curve so you may correlate on-screen
wells with hard copy logs that you may have. It is recommended that you take an opportunity to measure the
horizontal viewing area of your monitor in inches and then insert that value in the Monitor Width field. Be aware,
however, that if you adjust the screen width knob on your monitor, this will affect the monitor width setting.
Note: You must restart Power*Log / Core & Curve for the Monitor Width / Height changes to take effect.
This drop box option will display your directional surveys on your
log in either Quadrant format N 62 º W) or Azimuth format (AZ 298
º)
This check box
when activated will display the Sidewall Core Run & Core
numbers above the core triangle indicator on the Sidewall Core layer.
Favorites Tab
This tab allows the user to define their System favorites for all the data categories that support these choices. This
tab dialogue also allows the user to access the % Lithology Sort order for the % Lithology Track.

button when activated allows the user to determine the number of the
Rock Favorites - The
activation of the Rock Type Builder window in the Interpreted and Detailed Lithology tracks.
1.) Click on the

button in the System Options window.

2.) Click on the
button in the Rock Type Favorites list window to prepare it for the selection of your
Rock Favorites.
3.) Select the following Rock Types from the Rock Type Favorites list window:
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Anhy (prim) [Anhydrite (primary)]
Sh m gy [Shale medium gray]
Ss [Sandstone]
Plus any other rock types you would use a lot.
4.) Click on the
button to return to the System Options window.
Accessory Favorites - Allows the user to determine their favorite Accessories and then displays them in a pop-up
menu generated by the activation of the Accessory Builder window in the Interpretive
Lithology track.
1.) Click on the

button in the System Options window.

2.) Click on the
button in the Accessory Favorites list window to prepare it for the selection of
your Accessory Favorites.
3.) Select the following Accessories from the Thinbed, Components, and Cement headings in the Accessory
Favorites list window:
Thinbed
cht dk pebbles [chert dark pebbles]
sh gy stringers [shale gray stringers]
Component
aren [arenaceous]
fld grs [feldspar grains]
pyric [pyritic]
sac [salt casts]
slty [silty]
Cement
sils [siliceous]
Plus other components that you would use a lot.
4.) Click on the

button to return to the System Options window.

The Log Configuration Builder window


1.

This is the heart of the Log/Track/Layer configurations and controls the way your well’s information is displayed
on the log.
The well may have a lot of information stored in the database, but that information cannot be shown graphically
on the log until the necessary layers are built to illustrate that information.
Click on Log Configuration Builder under the Options menu on the Selection Bar or click on the Log
Configuration Builder

button on the Toolbar to activate window:
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Fundamentals of the Log Configuration Builder Window
The left side of the Log Configuration Builder window: Available Logs
The Available Logs section or left side of the Log Configuration Builder window allows you to take any track or
layer from Available Logs and add it to the log you are currently creating/building. On the left side of the window,
below the
radio button is a list of the tracks available for adding to the Active Log.
The Available Logs section or left side of the window contains the track and layer configuration of the SYSTEM
[SYSTEM] log, when the window first opens. You have the option of using any of the existing Tracks and their
associated layers or any of the existing Layers that are associated with any of the system logs in the log database.
The user can click on the
button on the left side of the screen to activate a selection
list of all log formats that are in your database. The list is comprised of two (2) names with the first name in the list
being the system Log Name and the second name (in brackets), being the UWI of its primary well. Double click on
the log format you wish to copy from.
Below the
radio button, on the left side of the window, is a list of the layers available in the track
highlighted above. They will be added all at once, if you add their parent track. However, they can also be added on
an individual basis, if you only want to add one(1) layer to an existing Active Log track.
The right side of the Log Configuration Builder window: Active Log
The Active Log section or the right side of the window displays the track and layer configuration of the Active Log
(the log you are currently creating), in the main Power*Log window. The name of the log is viewed in the Log field.
In this case, it will be “Tutorial Well.” Below the
radio button on the right side of the window, is a list of
the tracks that are currently found within the Active Log. The track at the top of this list is drawn on the left side of
the log, while the track on the bottom of the list is drawn on the far right of the log with all of the other tracks drawn
in between, respectively. Below the
radio button on the right side of the window, is a list of the layers
that are associated with the track highlighted above.
The middle of the Log Configuration Builder window: Selection Buttons
The selection buttons, found in the middle column of the window, are for adding layers or tracks from the
Available Logs to the Active Log, activating/deactivating the Active Log’s tracks, deleting active log tracks or
layers, and moving tracks or layers within the Active Log itself. Step-by-step instructions for accomplishing these
tasks are provided on the following pages.
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Working with the Log Configuration Builder Window
Deleting the Date and the Framework tracks on the Tutorial Log…
1.) Highlight the Date track on the right side of the window by clicking on it.
2.) Click on the

button. This action will prompt you with a system message, “Do you want to

delete the selected track in your log?” Click on the
removed from the Tutorial Log.
3.) Highlight the Framework track by clicking on it once.
4.) Click on the

button. The Date track has now been

button. This action will prompt you with a system message, “Do you want to

delete the selected track in your log?” Click on the
been removed from the Tutorial Log.
Adding a Slide - Rotate Track to the Tutorial Log

button. The Framework track has now

1.) On the left side of the Log configuration window scroll down the list of tracks and click on the Slide - Rotate
track. The track will become highlighted and the
radio button will become activated.
2.) On the right side of the Log configuration window click on the Depth Track. The track will become highlighted
and the
radio button will become activated.
3.) In the middle of the Log configuration window click on the
button. This will activate a System
Message asking the user “ Do you really want to ADD the selected (track) from the available log to the active
log?”
4.) Click on the

button. This will activate a Get Name window asking the user to name the track.

button
5.) The user may change the name or accept the Slide - Rotate as a name by clicking on the
and the track will be added above the Depth Track or to the left on the vertical log.
Resizing a track…
1.) Scroll down the tracks list, on the right side of the Log Configuration Builder window and click on the
Lithology Description track.
2.) Double click in the Track Width field and Type in the value of 2.5 Then, press the Tab key and the total width
of the log itself will change to reflect the increase in the width of the Lithology Description track as well as the
Log width field.
Note: For paper 8.5” wide, 8.00” is the widest that you want your log to be, especially if you are printing out the log
in the Portrait paper orientation.
Moving the Oil Show track…
1.) Scroll down the tracks list, on the right side of the Log Configuration Builder window, and click on the Oil
Show track to highlight it.
2.) Click on the
button and it will change to “
.” Then, click on the Lithology
Description track. The Oil Show track will then be placed above the Lithology Description track (to the left of
the Lithology Description track on the actual log).
Deleting the Gas Annotations layer from the Drilling Progress track…
1.) Scroll up through the tracks list, on the right side of the Log Configuration Builder window, and click on the
Drilling Progress track to highlight it. Notice that the layers associated with this track are displayed below, in
the Layers list box.
2.) Highlight the Gas Annotations layer, in the Layers list box, by clicking on it once. Notice that the
radio button is automatically activated by highlighting a given layer.
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button. This action will prompt you with a system message, “Do you want to

delete the selected layer in your log?” Click on the
been removed from the log

button. The Bit Record layer has now

Turning off a track…
1.) Scroll down the tracks list, on the right side of the Log Configuration Builder window, and click on the Test
track.
2.) Click on the
button to turn the “Y”(yes), to the left of the track name, to “N”(no), indicating that
the track will not be shown on the log, until it is reactivated.
3.) Alternatively, you can simply double click on the Test track to turn the “Y”(yes) to “N”(no). The user will notice
the log width has now decrease in size from 8” to 7.8” wide.
Resizing and Configuring the Drilling Progress Track
1.) Scroll up the tracks list, on the right side of the Log Configuration Builder window, and then highlight or click
on the Drilling Progress Track.
2.) Double click in the Track Width field and Type in the value of 2.45. Then, press the Tab key and the total
width of the log itself will change to reflect the increase in the width of the Drilling Progress Track as well as
increase the Log width field to 8”.
3.) Then, click on the
button (to the right of tracks), to activate the Track Configuration window.
The changes in step four have already been done in this example.

4.) Currently, the name of the track is Drilling Progress. To change the track name, Type “Drilling Rate” in the
Name field. Then, change the Heading name by typing “Drilling Rate” into the first Heading field. In the
second heading field, Type in the well name “Tutorial Well.” In the third heading field, Type in the location for
the Tutorial Well, “35-139-23155.” This would be beneficial if you were faxing or printing to Adobe the log only.
It would identify to the client the location of the well data that is being transmitted.
5.) Click on the
button to save your changes
6.) A system message will appear asking the User. “Record saved successfully. Do you wish to exit?” Click on the
button. This action will return you to the Log Configuration Builder window, where you will
see the new name of your track displayed on the log you are creating. Later, when you exit from the Log
Configuration Builder window, you will notice that the track headings have conformed to your changes.
7.) Press the Esc key on the keyboard or click on the
button to exit from the Log Configuration
Builder window. You will be returned to the main log window, where you will see the changes you have made
to the new log.
Importing ASCII File Data into the Drill Rate & Total Gas curve layers:
You will be able to do this import only if you have the LAS / ASCII Import Utility.
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1.) Click on the File pull down menu, select Import / Export and then select ASCII Import from the pop out
menu. OR the user can select the
File window.

Icon from the Import Tool Bar. This will activate an Open ASCII Data

2.) Navigate to the C:\Powersuite_2015\system folder and select the Imperial Vertical ASCII TG & ROP
curve.txt file. Click on the
be activated.

button. Once the file has been selected the Set delimiter window will

3.) This file is a Space delimited file and the default on this window is space delimited. You will see <column
break> between the data points. Click on the

button. This will open the Import window.

4.) The default on the Depth column is Column 1 which is indicated by the purple X. In our case the depth is the
first column so we do not have to change the depth column indicator.
5.) Click on the Column 2 on the left side and drag it to the Total Gas Curve layer on the right side of the
window. You will see Column 2 in the mapped Data field and an APPEND in the action field.
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6.) Click on the Column 3 on the left side and drag it to the Drill Rate Curve layer on the right side of the
window. You will see Column 3 in the mapped Data field and an APPEND in the action field.
Button. This will import the curve data and prompt you with a database message saying
7.) Click on the
Imported successfully.

8.) Click on the

button to close the window.
button to close the ASCII Import window.

9.) Click on the
Changing Curve Scales

1.) Click anywhere in the Drilling progress track to make it active. It will have a
green outline. Go to the layer selection list and select drill rate layer from the
list to make it the active layer.
2.) Right click anywhere within the Drilling Rate track (Drill Rate Layer) to activate
the pop-up menu.
3.) Select Scale from the pop-up menu to activate the Curve Scale window for the
Drill Rate curve. In this figure the user will notice the Scale has already been
changed.

4.) Notice that the default scale (when the curve was originally added to the log),
was 0 to 15 min/m, as you would see in your window. To change the original
scale from 0 – 15 min/2ft to 0 – 30 min/2ft , simply adjust the Right / Top Scale value to 30 by double
clicking in the Right Scale field and typing in a value of 30.
Note: The backup scale (in this case straight shift), is there in case the curve values go off-scale (more than 30
min/2ft). A straight shift backup scale for an original scale of 0 to 30min/ 2ft would be 30 to 60 min/2ft for Left
and Right Scale values, respectively.
5.) Click on the

button and select

from the ensuing Shortcut Options window.
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**Your log should now look like the log shown below**
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Adding Sample Descriptions
1.) Click on Sample Description, under Reports on the Power*LogTM Selection Bar to open the Sample
Description window.

2.) Type 6000 into the Interval (From) field and then press the Tab key
3.) Type 6029 into the Interval (To) field and then press the Tab key
4.) Type Anhy into the Rock Type / Heading field and then press the Tab key 4 times to get to the short
description field.
Note: The rock types have to be typed in correctly in the Short form field (according to our Geological Expansion
Dictionary) in order for the Rock Type to be filled in when the Enter key is depressed.
5.) Type the following description into the Short Description field, exactly as it appears below:
wh, lt gy, crpxl, com sacs, sft, dns, ns.
Note: The Short or Long Descriptions can be transferred to the Lithology Description layer and only the Long
Description will be printed out in the Sample Description.
6.) Select the Automatic Transfer, Transfer Depth Range and Transfer Short Form check boxes (
shown in the preceding sample description window.

), as

7.) Click on the
button and then select
from the ensuing Shortcut Options window.
You will see your sample description on the log at 6000 ft with the options selected in step 6.

Adding another Sample Description to the same interval…
1.) Type Sh into the Rock Type field, tab 4 times and Type the following description into the Short Description
field:
lt gy, wxy, bentic, occly slty, tr aren grs, sft, blky.
2.) Deselect Transfer Depth Range check box (

).

3.) Click on the
button and then select
Your description will now be viewed at 6002 ft.
Note: If you have made any typing errors the user can click on the
necessary corrections and then

from the ensuing Shortcut Options window.
button, then you can make any

the record once again to replace the old record with the new one.
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Adding another Sample Description to a new interval…

button to advance the description interval from depth to 6029. Type in a new depth
1.) Click on the
to 6041.
2.) Type Ss into the Rock Type field, tab 4 times and then Type the following description into the Short
Description field:
wh, lt gy, vf - f gred, w srt, sbang, qtz, tr wthrd fld grs, sils cmt, p intgran por (3-7%), sl tr
ptch brn o stng, dull yel flor, fr stmg mky yel cut flor.
3.) Select Transfer Depth Range check box (

).

4.) Click on the
button and then select
You will see your description at 6029 ft.



from the ensuing Shortcut Options window.

Adding more Sample Descriptions to a new interval…

button to advance the description interval from depth to 6041. Type in a new depth
1.) Click on the
to 6056.
2.) Type Ss into the Rock Type field, tab 4 times and then Type the following description into the Short
Description field:
wh, lt gy, vf - m gred, modly w srt, sbang, qtz, tr wthrd fld grs, tr dk cht pbls, sils cmt, fr
intgran por (6-10%), q brn o stng, no cut flor.
3.) Deselect the Transfer Depth Range check box (
4.) Click on the
button and then select
You will see your description at 6041 ft.

1.)

).
from the ensuing Shortcut Options window.

Adding our Last Sample Descriptions utilizing the Auto Next button…
Click on the
depth to 6070

button to advance the description interval from depth to 6056. Type in a new
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2.)

Type Sh into the Rock Type field, tab 4 times and then Type the following description into the Short
Description field:
m - dk gy, micmica, v carb, calcs, fis.

3.)

Deselect the Transfer Short Form check box (

4.)

button and then select
Click on the
will see your description at 6056 ft.

).
from the ensuing Shortcut Options window. You

Printing out Sample Descriptions to Word. (Only if you have Word for Windows)
Print
1.) Click on the
Reports to Word button on
the Toolbar or select Print
Reports to Word
Selection, under the File
menu, on the Selection Bar
to activate the Power*Log
Report: Well End Report
window.
2.) The Reporting Tool print
window will automatically
default to the active
Well/Log Name.: You will
see Tutorial Well in the
Choose a Well field If it is
not the defaulted well then
go to the Well list drop box
and select it from the List.
3.) Highlight Sample Desc in the Reports field by clicking on it
once.
4.) Leave the Depth Range field blank to print all the
descriptions.
5.) Click on the

check box

7.) Click on the
button in the Well End Report window to printout the Sample Descriptions. This
will activate you word program and you will get the Sample descriptions and Formation tops that were input
through the Reports window.
8.) When you are finished, press the Esc key on the keyboard to exit from the Well End Report window and to
activate the following system message, “Do you want to save the setup” Clicking on the
button and the window selections you have just made will be remembered for the next time. Clicking on the
button will remember the default selections that were set for this window.
Printing out Sample Descriptions (If you do not have Word for Windows)
1.) Click on the
Print Well End Report button on the Toolbar or select Print Well End Report, under
File, on the Selection Bar to activate the Power*Log Report: Well End Report window.
2.) The Well End Report print window will automatically default to the active Well/Log Name and its associated
API: you will see Tutorial Well (35-139-23155) in the Well List field and it should be highlighted. If it is not
highlighted, move the mouse pointer to the Well List field and click on the desired Well / Log Name to
highlight the Well you wish to print information from.
3.) Highlight Sample Descriptions in the Reports field by clicking on it once.
4.) Select Printer from the Output drop box field list.
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5.) Click on the
button, in the upper right corner of the Well End Report window, to activate the
Print Setup window. Notice that the currently selected printer is listed beneath the Default printer radio button
( ), at the top left of the Print Setup window. Use the Printer section of the Print Setup window to specify
the use of a printer other than the default printer.
Note: Power*Log™ automatically defaults to a Paper Orientation of Portrait and a Paper Size of 8 5 x 11, as
specified in the Orientation and Paper sections, respectively, of the Print Setup window. Please do NOT change
these default settings.
6.) Make sure that the All check box (
Report window, is activated.
9.) Click on the

), in the Sample Description section at the lower right of the Well End

button in the Well End Report window to printout the Sample Descriptions.

10.) When you are finished, press the Esc key on the keyboard to exit from the Well End Report window and to
activate the following system message, “Do you want to save the setup configuration?” Click on the
button and all of the printer selection/settings information utilized in the Well End Report
window will be saved to the database for any future Well End Report print jobs. Clicking on the
button will also return you to the main log window.
Drawing Interpreted Lithology
Note: To work on any layer in any track, simply double click on the track in which you wish to work to activate the
“builder” window for that particular layer. Once the “builder” window for a given layer is active, you are then able to
access the pop-up menu [right click] associated with that “builder” window and may proceed to enter any
necessary intervals and graphical descriptions for the given layer.


Drawing Rock Types…

1.) Double click anywhere within the Interpreted Lithology track to activate the Rock Type Builder window and
the Toolbox with your Favorites Rock Type List.

2.) The user can move the Tool Box to a position where it is out of the way by clicking and dragging the Tool Box
menu bar.
Note: The graphical images utilized in the Tool Box window represent specific Rock Types selected by the user in
the System Options, Favorites Tab window (See System Options earlier in this tutorial). The written descriptions
of the Rock Types illustrated in the above diagram were included as a visual aid and do not normally accompany a
pop-up menu.
3.) Select the Rock Type for Anhydrite (primary) from the Tool Box window and it will automatically be displayed
in the Rock Type field within the Rock Type Builder window.
4.) Define the top interval by clicking and holding the left mouse button at 6000’ on the Interpreted Lithology
track.
5.) Define the bottom interval by dragging the mouse pointer to 6029’
6.) Release the mouse button and the interval will be drawn accordingly.


Drawing another Rock Type…
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1.) Select the Rock Type for Sandstone from Tool Box window and it will automatically be displayed in the Rock
Type field within the Rock Type Builder window.
2.) Define the top interval by clicking and holding the left mouse button at 6029’ on the Interpreted Lithology
track.
3.) Define the bottom interval by dragging the mouse pointer to 6058’

on the Interpreted Lithology track.

4.) Release the mouse button and the interval will be drawn accordingly.
And another...
1.) Select the Rock Type for Shale (medium gray) from the Tool Box window and it will automatically be
displayed in the Rock Type field within the Rock Type Builder window.
2.) Define the top interval by clicking and holding the left mouse button at 6058’ on the Interpreted Lithology
track.
3.) Define the bottom interval by dragging the mouse pointer to 6070’
4.) Release the mouse button and the interval will be drawn accordingly.

on the Interpreted Lithology track.

Note: You may wish to resize a particular bed or lithologic interval, but remember that beds cannot completely
overlap one another. Also, keep in mind that only the top or the bottom of a particular bed can be resized at any one
time. Accordingly, if you wish to resize both, you will have to do it twice.


Resizing an interval…

N.B. If you have the
checked and your mouse pointer accuracy is 1 you must uncheck the check
box to resize the following bed or decrease the mouse pointer accuracy.
1.) Press and hold the Ctrl key on the keyboard down, while hovering over the bed boundary between the Shale
and Sandstone bedding contact at 6058 ft. You will view a mouse pointer turn into resize arrow and if the
shale is viewed in the builder click and drag the left mouse button up two feet to 6056 ft on the Interpreted
Lithology track.
2.) Release the mouse button at 6056 ft, followed by the release of the Ctrl key on the keyboard, and you will be
prompted with the following system message, “Do you really want to resize the interval from 6058.00 –
6070.00 to 6056.00 - 6070.00?”
3.) Click on the
button.
4.) Press the Esc key on the keyboard to exit from the Rock Type Builder window and return to the log.
Deleting a Single Rock Type or Bed
1.
2.

Right click anywhere within the Interpreted Lithology track to activate the pop-up menu.
Click on Delete and the following system message will be activated, “Do you really want to DELETE _ to _ ?”

3.

Click on the
button to confirm the deletion.
Press the Esc key on the keyboard to exit from the Rock Type Builder window.
Deleting Multiple Rock Types or Beds

1.

Hold the SHIFT Key down and then click and drag anywhere within the Interpreted Lithology track and
then let go of the Shift Key and left mouse button. This will activate a Delete Intervals message box.

2.

Click on

button and the Intervals dragged over will be deleted.

Note: When you delete a Rock Type, you will also delete its associated bed restricted rock description information,
i.e. Grain Size, Porosity Grade, Type, Oil Show and all other bed restricted data.
3.

Press the Esc key on the keyboard to exit from the Rock Type Builder window.
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**Your log should now look like the log shown below.**

Editing Lithology Descriptions
In these examples we will start from the lower descriptions and work our way up the transferred descriptions. We
will demonstrate to the user how to change the position, delete and modify transferred sample descriptions.
1.) Make the Lithology Description layer active (in the Layer Selection List field), by clicking once anywhere
within the Lithology Description track to highlight the Lithology Description track in green.

Overview of RTF Font Toolbar buttons.

At the flashing cursor or with some text highlighted this button will activate a Font Dialogue window to
change Font Type, style, size etc.
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At the flashing cursor or with some text highlighted this button will activate a Bold Font style.
At the flashing cursor or with some text highlighted this button will activate an Italic Font style.
At the flashing cursor or with some text highlighted this button will activate an Underline Font style.
At the flashing cursor or with some text highlighted this button will activate an Strikethrough Font style.
At the flashing cursor or with some text highlighted these buttons will orient the text line or
paragraph left, centered or right within the box outline.
At the flashing cursor or with some text highlighted this button will place a bullet at the start of the text line
or paragraph.
At the flashing cursor or with some text highlighted these buttons will indent or tab the text line or
paragraph either left or right.
At the flashing cursor or with some text highlighted this button will activate a new Font color.
At the flashing cursor or with some text highlighted this button will activate a Font background color.

Overview of RTF Lines and Boxes Toolbar buttons.

Left Right Centered Text boxes: With the text box or annotations outline activated these buttons will
orient the text box left, centered or right within the track borders. The user can also click and drag on the box outline
to any orientation on the track which will override these buttons.
Display scale drop box: This allows the user to change the display scale for each annotation to
adapt to the printed or viewing scale of the log. The All Scales selection will display the annotation
at all viewing and printing scales from 1:1 to 1:5000. If you select a different display scale then the
annotation will be viewed at that viewing and printing scale and smaller. Anything larger than the
display scale and the annotation will not be viewed or printed. This should alleviate the annotations
overlapping each other when printed out on different scales. For example if the user were to choose
1:120 the annotation would show up on viewing / printing scales from 1:120 to 1:5 and not show up
on scales from 1:121 to 1:5000.

Line Style Selector and Line Thickness drop boxes: These drop boxes allow the
user to select a different line style for their drawn line as well as the line thickness for
the line that is associated with each individual annotation. You can only have one line
per annotation. The line can only be redrawn and not moved.

This button will show / hide the text for a particular annotation. The text will not hide itself until the annotation
is clicked outside of or deselected.
This button will show / hide the line for a particular annotation.
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This button will show / hide an outline around the annotation. The grey box you see around all annotations will
not be printed. Only when this button is activated will the box be printed.
Will show / hide an arrow pointer at the end of a line draw.
Will show / hide an arrow pointer at the start of a line draw.
Will show / hide an tail at the end of a line draw.
Will show / hide an tail at the start of a line draw.

Moving a Lithology Description:
1.) Click anywhere within the Shale description that is viewed on your log at 6060 ft to activate the RTF Font
and RTF Line and Boxes toolbars and highlight the text.
2.) Move the mouse pointer to the outline and you will see the pointer turn into a
drag your mouse to move the description down 4 feet to 6064 ft.
3.) Click outside the annotation to save your annotations.

crosshair. Click and

Editing Sample Descriptions
1.) Now we will edit the Shale description at 6001 ft. Click in the Sh description at 6001 ft. You will see the
description outlined on the log.
2.) Move the mouse pointer to the outline and you will see the pointer turn into a
crosshair. Click and
drag your mouse to move the description down 11 feet to 6012 ft.
3.) Move your mouse pointer in the text field and click between the Sh and the (:) colon and Type in Lams.
4.) Click outside the annotation to save your annotations.
5.) Move the other annotations so that fit on the layer without overlapping each other and then Click outside the
highlighted annotation to save your changes. Follow the example below.
**Your log should now look like the log below.**
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Drawing Porosity (%)
1.) Double click on the Porosity (%) track to activate the Porosity Builder window.

2.) Double Click the mouse pointer (with the
[6%]

check box activated) between 6029’ and 6056’ @

and the entire interval will be drawn accordingly in purple to represent an entire interval.

3.) Click and drag the mouse pointer from 6042’ [8%] to 6056’
, release the mouse button, and the
desired Porosity Grade wIll be drawn accordingly in green to represent a subinterval.
Note: The mouse pointer does NOT have to be dragged to the same percentage (%) point at the bottom of the
interval, as you selected at the top of the interval: the mouse pointer needs only to be dragged to the desired depth.


Deleting Porosity (%) Entire or Subinterval…

If you wish to delete a Porosity (%) subinterval or entire interval, while the Porosity Builder window is open, right
click within the interval slated for deletion to activate a pop-up menu, and then left or right click on the appropriate
selection.

Drawing Grain Size
1.) Double click on the Grain Size track between 6029 ft and 6056 ft to activate the Grain Size Builder window.

2.) Click and drag the mouse pointer from 6029’ [vf snd] to 6056’ [f snd]

on the Grain Size track.

Note: Measured Depths and Grain Sizes, like 6029’ [vf snd], can be viewed within the mouse pointer display box,
situated just to the right of the mouse pointer.
3.) Release the mouse button and the entire Grain Size interval will be drawn in purple to represent the entire
interval accordingly.
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Drawing a Grain Size Sub-Interval…

.
1.) Click and drag the mouse pointer from 6042’ [vf snd] to 6056’ [m snd]
2.) Release the mouse button and the Grain Size Sub-Interval will be drawn accordingly.
3.) To exit from the Grain Size Builder window and return to the log, press the Esc key on the keyboard once.
Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also
there is an

button on the Toolbar.

Drawing Oil Shows
1.) Double click on the Oil Show track between to activate the Oil Show Builder window.

2.) Right click anywhere within the depth interval of 6029’ to 6056’ on the Oil Show layer to activate the pop-up
menu.

Note: The symbols utilized in the pop-up menu, represent a specific percentage (%) or amount of oil staining, as
illustrated in the above diagram.
3.) Select 50-75% oil staining from the Sub Interval pop-up menu.
4.) Click and drag your mouse pointer from 6029’ to 6041’
and release the mouse button and this 12 ft
sub-interval will be populated with the 50-75% oil staining symbol ( ).
Drawing Sorting
1.) Double click on the Sorting track between 6029’ and 6056’ to activate the Sorting Builder window.

2.)

Right click anywhere within the 6029’ and 6056’ Sorting interval to activate the pop-up menu.
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Note: Each of the abbreviations utilized in the pop-up menu represent a specific degree of Sorting.
3.) Select w for the Entire Interval from the pop-up menu and the entire bed will be populated with the “W”
symbol.


Drawing a Sorting sub-interval…

1.) Right click anywhere within the Sorting Track to activate the pop-up menu.
2.) Select modly w from the Sub Interval pop-out menu.
3.) Click and drag your mouse from 6041’ to 6056’
“mW” symbol.

and one 15’ sub-interval will be populated with the

Drawing Rounding
1.) Double click on the Rounding track between 6029’ and 6056’ to activate the Rounding Builder window.

2.) Right click anywhere within the 6029’ and 6056’ Rounding interval to activate the pop-up menu

3.) Select sbang for the Entire Interval from the pop-up menu and the entire bed will be populated with the “a”
symbol.
Drawing Porosity Type
1.) Double click on the Porosity Type Track to activate the Porosity Type Builder window

2.) Right click anywhere within the Porosity Type track activate the pop-up menu and then select types to
activate the pop-out menu.
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3.) Select x from the pop-up menu and click at 6029’, 6035’, 6041’, 6047’ and 6053’ and “x’s will appear at those
depths.
Note: If you happen to do something wrong remember you have an UNDO under the Edit Menu selection. Also
there is an

button on the Toolbar.

Drawing Slides on the Slide / Rotate Track
We can also import the slides and Toolface orientation but for this example we will do this manually. In the
Power*Curve tutorial we will import the slides from a *.txt file.
1.) Double click on the Slide - Rotate Track to activate the Slide – Rotate Builder window

2.) Click and drag your mouse within the track from 6024 to 6027 ft
and then let go. The slide will
automatically be drawn for you with an S.
3.) To enter the Toolface orientation click on the slide that you just dragged in and
then type 120 in the Toolface field and then click on the Right radio button.
4.) Click on the
button.
5.) To change the font orientation from the default Horizontal on the slide right click
on the Slide you just modified with the Toolface to activate the pop out menu
and select the Vertical Orientation.
6.) To RESIZE an interval you would hold the CTRL key and mouse over an end
point of a slide to turn the mouse pointer into a resize arrow click and drag
your mouse to a new depth interval drawn. OR Click on the interval to place its
attributes into the builder and then type in a new start or end depth and then click
on the
button.
7.) To DELETE right click on the drawn interval and select delete from the pop-out
menu.
Drawing Accessories
Using the log on page 35 as a guideline, add some Accessories to the log at your discretion. Listed below are the
steps for adding Accessories:
1.) Double click anywhere within the Interpreted Lithology track to activate the Rock Type Builder window.
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2.) Right click anywhere within the Interpreted Lithology track to activate the pop-up menu.
3.) Select Acc Builder from the pop-up menu to activate the Rock Accessory Builder window or click on the
button in the Rock Type builder.

4.) Now the user can move the Toolbox Favorite List by clicking and dragging the menu bar to a convenient
location.

Adding a Thinbed…
1.) Click on the symbol for Shale Gray Stringers from the Tool Box Favorites List and the Thinbed field in the
Rock Accessory Builder window will be filled in with sh gy stringer [shale gray stringers].
2.) Click anywhere within existing Interpreted Lithology to insert the desired Accessories.


Adding another Accessory…

1.) Click on the symbol for Chert Dark Pebbles from the Tool Box Favorites List and the Thinbed field in the
Rock Accessory Builder window will be filled in with cht dk pebbles [chert dark pebbles].
2.) Click along the bottom of the Sandstone interval to insert the desired Accessory.
Note: When placing Accessories on the log, you may wish to increase the mouse accuracy from the default of 1 to
0.1. This selection box is located to the left of the LAS button on the Toolbar.


Adding another Accessory…

1.) Click on the symbol for Salt Casts from the Tool Box Favorites List and the Component field in the Rock
Accessory Builder window will be filled in with sac [salt casts].
2.) Click anywhere within the Anhy(prim) interval to insert the desired Accessory.


Adding another Accessory…

1.) Click on the symbol for Silty from the Tool Box Favorites List and the Component field in the Rock
Accessory Builder window will be filled in with slty [silty].
2.) Click within the Anhy (prim) interval to insert the desired Accessory/Accessories.
 Add the following Accessory and Grain…
Arenaceous


Feldspar Grains

Adding Cement…
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1.) Click on the symbol for Siliceous from the Tool Box Favorites List and the Cement field in the Rock
Accessory Builder window will be filled in with sils [siliceous].
2.) Click anywhere within the existing Interpreted Lithology intervals, that you wish to insert the desired
Accessory/Accessories.
3.) Press the Esc key on the keyboard to exit from the Rock Accessory Builder window.
Moving an Accessory
1.) Click and hold your mouse pointer down on the Accessory (see a red box) and drag to a new spot.
Deleting a single Accessory
1.
2.
3.

With the Rock Accessory Builder window activated right click (in the upper right
corner) of the Accessory symbol you wish to delete and the pop-out menu will be
activated.
Click on the Delete selection from the pop-out menu and the selected Accessory
symbol will be deleted.
Press the Esc key on the keyboard to exit from the Rock Accessory Builder window.

Deleting Multiple Accessories
1.
2.

With the Rock Accessory Builder window activated Press and Hold the SHIFT Key and then click and drag
an area where the symbols are that you want to delete.
Release the mouse button and this will activate a message.

3.

Click on the

button. The accessories that were covered by your drag will be deleted.
**Your log should now look like the log below.**
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Adding a Cored Interval to the log
1.) Double click on the Core track to activate the Well Core report window.

2.) Type 1 into the Core # field. Tab key.
3.) Type today’s date into the Coring Date field, using the Date Format (MMM DD, YYYY), selected in the
System Options window at the beginning of this tutorial. Tab key.
4.) Type 6072 into the Interval (From) field, Press the Tab key, Type 6106 into the Interval (To) field, Press the
Tab key and Type 32 into the Recovered field.
5.) The rest of the fields can be filled in. Only the yellow fields are mandatory. Remember to Tab between fields.
6.) Click on the

button and select

from the ensuing Shortcut Options window.

Adding Core Descriptions
1.) Click on the

button, in the Well Core window to activate the Core Description window.
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2.) Type 6072 into the Interval (From) field, tab and Type 6085 into the Interval (To) field, tab and then Type Sh
/ mnr – abnt Ss strgs into the Rock Type field. Tab to get to the short description field.
3.) Type the following Core Description into the Short Description field, exactly as is:
Sh lt gy, occly mot dk gy, micmica, v carb, slty, plty & fis. Occ tr Sid nods & unident fos
deb. Ss strgs pred @ the top of zn, v thn <2 mm thk, s&p, vf gred, py srt, sbrdd, arg & tt /
ns.
Note: The Short or Long Descriptions can be added to the Lithology Description layer (in the Lithology
Description track and only the Long Description will still be printed out in the Core Description Report in the
Well End Report window.
4.) Select the Automatic Transfer, Transfer Depth Range and Transfer Short Form check boxes (
shown in the preceding sample description window.

), as

5.) Click on the
button and then select
from the ensuing Shortcut Options window.
This will activate a System Verification Window asking you if you want to change your screen scale to 10” so
you can see your description. Otherwise, it will not be shown.

6.) Click on the
button. You will see your sample description on the log at 6070 ft with the options
selected in step 4.

Adding another Core Description to a new interval…
1.) Type 6090 into the Interval (To) field, tab and then Type Ss into the Rock Type field. Tab to get to the short
description field.
2.) Type the following Core Description into the Short Description field, exactly as is:
s&p, m gred, w srt, sbrdd, qtz, cht, sils cmt, fr – g intgran por (16% - 18%), abnt brn o stng,
bri yel flor, ex stmg yel cut flor.
3.) Click on the

button and then select
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Note: If you made any typing errors, you can make any necessary corrections now and then Save the record once
again to overwrite the old record. You must first delete the description from the Lithology Description Layer.

1.)
2.)

3.)

1.)
2.)

3.)

1.)

Adding yet another Core Description to a new interval…
Type 6096 into the Interval (To) field, tab and then Type Sh into the Rock Type field. Tab to get to the short
description field.
Type the following Core Description into the Short Description field, exactly as is:
lt gy, occly mot dk gy, micmica, v carb, slty, plty & fis.
Click on the
window.

button and then select

from the ensuing Shortcut Options

Adding yet another Core Description to a new interval…
Type 6102 into the Interval (To) field, tab and then Type Ss into the Rock Type field. Tab to get to the short
description field.
Type the following Core Description into the Short Description field, exactly as it appears below:
s&p, m - vc gred, m srt, sbrdd - rdd, qtz, cht, tr sils cmt, g - ex intgran por (20% - 24%), v fri,
v abnt brn o stng, bri yel flor, ex stmg yel cut flor.
Click on the
button and then select
window.
Adding the last Core Description to a new interval…

from the ensuing Shortcut Options

Type 6106 into the Interval (To) field, tab and then Type No Recy into the Rock Type field. Click on the
button. This will expand the abbreviated Rock type into the Long name Rock type field.

2.)

Click on the

button and then select

from the ensuing Shortcut Options window.

Editing Core Descriptions
Before we start editing the Core Descriptions on the Log we must first change our Screen scale from 1:120 to 1:48
so that all the descriptions will not be overlapping each other. This will make selecting them much easier.
1.) Click on Log Scales, under the View menu selection, to activate the pop out menu and then click on
Imperial then click on the 1:48. This will refresh your log with the new Scale. Or Click in the Log Scales field
drop box and select 1:48.
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Moving and changing the Display Scale options

Changing the Display Scale options

1.) Click on the 6096-6102 ft Core Description. This will activate the RFT Font and Lines and Boxes toolbars and
show a highlight around the selected annotations borders.
2.) To change the Display Scale of the Core Description now highlighted, simply select All Scales from the
display scale drop box to replace the 120 in the RFT Lines and Boxes Toolbar. (When this is done the core
description will display at all log viewing and printing scales.)
3.) Move your mouse pointer onto the bordered area on the lithology description track and so that the mouse
pointer turns into
cross hairs and click and drag to move this description so that it can be read easily.
4.) Click anywhere outside the annotation to close down the RFT Builders.
Moving Core descriptions
1.) Click on the Core Description you wish to move.
2.) Move your mouse pointer onto the bordered area on the lithology description track and so that the mouse
pointer turns into
cross hairs and click and drag to move this description so that it can be read easily.
Release the mouse button, and the Core Description will be redrawn at its new location.
For a general guideline refer to the log example on page 45.
Resize the Moved Annotations to fit the track width
When annotations are moved or manually placed in an annotation layer, the user
may want them fitting perfectly between the track edges.
1.) Right Click anywhere on the lithology description layer. This will activate
the pop out menu.
2.) Select Resize to Track. This will activate the Format Range Window.
3.) Accept the Depth Interval by Clicking on the
the annotations to fit the track width.

button. This will resize

Deleting Core Descriptions
1.) Click on the Core Description you wish to delete to highlight it.
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2.) Right Click anywhere inside the annotation to activate the pop up menu shown below.

3.) Click on the Delete selection.
4.) Click anywhere outside the annotation to close down the RFT Builders.
Adding a Core Rate curve layer to the log.
1.) Under the Options menu, click on Log Configuration Builder or click on the
Log Configuration
Builder button on the Toolbar to activate the Log Configuration Builder window.
2.) On the left side scroll down in the tracks portion of the window until you can highlight the Curves Track by
slicking on it.
3.) Click on the Core Rate layer in the layers portion of the window on the lower left side of the builder to highlight
it. Also notice the
radio button on the left side gets activated.
4.) On the right side (Active Log) of the Log Configuration Builder window, click on the Drilling Rate track to
highlight it. This is the track we want to add the Core Rate layer to.
5.) Click on the

button and you will be prompted with the following system message, “Do you

want to ADD the selected (layer) from the available log to the active log?” Click on the
button.
6.) This will activate a Get Name window with “Core Rate” as the name in the New Layer Name field. Click on
the

button and the Core Rate layer will then be added to the Drilling Rate track.

Note: The Core Rate curve has not yet been associated with the Core Rate layer. This will be done when the Add
Curve window has been correctly filled in.
7.)

Click on the
button to return to the log and the log will be initialized with the new layer, which
in turn will generate an Add Curve window.

7.) Click on

button to add the curve layer to the Drill Rate Track.
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Importing an LAS Core Rate Curve data file
1. Click on the File pull down menu selection and click on Import and then click on LAS from the pop out-menu
or simply click on the

LAS button, on the Import Toolbar, to activate the LAS Reader window.

2. This will then activate the Open window which allows the user to select the LAS file you wish to import the data
from. You can find the file in the PowerSuite_2015\System\Imperial Core Rate Curve.las and highlight the file by
clicking on it once and then click on the
default to the importing of Curve data.

button. You will see the window shown below. We will

Overview of window
The left hand side of the LAS Reader window (shown on the right) allows the
user to see the tree view of the data file format including the different data,
parameter and definition blocks. The tree enables the user to select different sets of
data or definitions. We have the choice to import these data types into the
predefined data sets such as curves, Inclinometry, Tests, Tops and Core Data
within the Power*Suite application. We default the window to select the log data or
curve data if it is available
The upper right hand side of the LAS Reader window (shown to the right) allows
the user to see the data associated with the different data and parameters and
definition blocks.
The bottom left hand side of the LAS Reader window (Shown below left) displays
the curve data sets that available to be imported. These can then be dragged to the
import side of the LAS reader.
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The bottom right hand side of the LAS Reader window (shown above right) shows the Import side displaying the
Curve Layers and Curve names associated with the log that is open and active at the time the LAS Reader window
was invoked.
Importing LAS Curve Data files
1. On the lower left side of the window Click and drag the Core Rate curve to the Core Rate layer on the lower
right side and release it when the layer name becomes highlighted.
N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from append to
replace. The Symbol color will either be purple for replace or blue for append.
2.

Click on the

button. You will then be prompted with a system message after the import has finished.

3.

button and then click on the
Acknowledge the Finished Import message. Click on the
to exit or click on the File menu and select the Exit option to close the LAS Reader Window.

button

Adding Coring Times to the existing Drill Rate curve…
1.) Select the Drill Rate curve layer from the Layer Selection
List field to make Drill Rate the active layer.
2.) Then, Double click on the Drilling Rate track to bring up the
Curve Editor window for the Drill Rate curve layer.
3.) Change the Auto Depth Increment from one (1) to two (2)
and then enter the following values into the Curve Editor
window.
6072
6074
6076
6078
6080
6082
6084
6086
6088

13.0
11.5
13.2
13.2
14.0
13.4
13.0
8.5
4.8

4.) Click on the
in min/m).

6090
6092
6094
6096
6098
6100
6102
6104
6106

4.4
11.0
12.5
10.0
6.0
5.0
4.0
12.0
28.0

button to save your Drill Rate (Core Rate
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Changing Curve Scales in the Curve Editor window.

1.) Click on the
button in the Curve Editor window. This will activate a Curve Scale window. We
will be changing scales in our case at 6066’

2.) Type in a different from Depth Interval changing the 0 to 6066 and then click on the
activate a System message stating Record Saved Successfully.
3.) Click on the

Button. This will

button. This will clear the window.

4.) Type in 6066 in the from depth interval field, tab, Type 10000 in the to depth interval field, tab, Type in 0 in
the left / bottom scale field, Type in 60 in the right / top scale field, select strait shift from the Backup
Scale drop box.
5.) Click on the
message box.

button and then select

from the ensuing Record Saved Successfully

6.) Press the Esc key on the keyboard or Click on the
button in the Curve Editor window to exit
from the Curve Editor window. This will return you to the main log and you will now be able to view your drill
rate additions and the change of scale.
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**Your log should now look like the log below at 1:240 or 5” scale.**

**Your log should now look like the log below at 1:120 or 10” scale.**
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Adding a Formation Top
1.) Click on Formation, under Reports menu on the Menu bar, to activate the Well Formation window.

2.) Type ab into the Formation Short name field, tab and Type Albequerqui into the Formation Long Name
field, select Mesozoic from the Era Drop down box, select Lower from the Series Drop down box, select K
[Cretaceous] from the Period Drop down box, and select Santonian from the Stage Drop down box.
3.) Move the mouse pointer to the Prognosis TVD field and click. This will activate a cursor and type in 6080
in the Prognosis TVD Top field and press the tab key
4.) Type 6085 in the Sample Top (MD) field and press the tab key
5.) Type 6084.2 in the Sample Top (TVD) field.
6.) Click on the

button and select
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Draw the Interpreted Lithology (Please refer to the section on Drawing Interpreted Lithology earlier in this
tutorial), for the Core Descriptions, that you have already created. Your Log should look fairly similar to the
log illustrated below. To draw Lithology with more accuracy you may want to change the accuracy of your
mouse pointer or the screen scale accuracy to from 1 foot (default) to a more detail mouse pointer. To do
this click on View menu selection, select screen scale accuracy and select from the pop-out menu.

Adding Annotations
1.) Click on the Drilling Rate track to make it active (highlighted in green).
2.) Select Eng - Mud Parameters, as your active layer, from the Layer Selection List field.
3.) Click and drag an area within the Drilling Rate track with the left mouse button depressed on the layer to
define where the annotation will be viewed which will activate the RTF Toolbars.
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4.) Type the following into the text field in the annotation layer:
FOB: 1-1.2
RPM: 50-70
SPM: 95
VOL: 65
5.) To change the Font Color Highlight the Text you want to change by dragging the Mouse over the text to
highlight the letters.
6.) Click on the

button in the RFT Font toolbar. This will activate the color palette.

7.) Click on the new color and then click on the
button.
8.) Click anywhere outside the text box to save your annotation.
Adding a Curve Fill layer to an existing log
1.) Click on Log Configuration Builder, under Options, or use the Log Configuration Builder
button on
the Toolbar to activate the Log Configuration Builder window.
2.) On the left side of the window, click on the Curve fill track containing the Curve fill layer.
3.) Click on the Curve Fill Layer, that you wish to add to your log, within the Layers section on the left side of
radio button become activated
the Log Configuration Builder window. You should notice the
4.) On the right side of the window, highlight the Drill Rate track so that you add the selected Curve Fill layer to
this track.
5.) Click on the
button to add the selected layer to the track on your log and the following
system message will be activated, "Do you want to ADD the selected <LAYER> from the available log to
the active log?"
button to activate the Get Name window.
6.) Click on the
7.) You now have the option of either renaming the layer or simply leaving it with its original name. Type in
ROP/TG Curve Fill.
Note: Two layers cannot share the same name. Accordingly, no layer will be added to your track if they share the
same name as a layer that already exists on the active(your) track.
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8.) Click on the
button to add the layer to your log and place its name in the active Layers list on
the right side of the Log Configuration Builder window.
button to get out of the Log Configuration Builder Window. . This should activate
9.) Click on the
the Curve fill option window. If so skip to step 3 in the setup directions.
Setting up the (2) Two Curve Fill options
Once the layer has been added to your log the user can now utilize the curve fill layer.
1.) To set the Curve Fill Options the user must first make the Curve Fill Layer active. To do so the user must
Click on the Drill Rate Track containing the Curve Fill layer and then selecting the ROP/TG Curve Fill layer
from the Layer Selection List field at the far left of the Selection Bar.
2.) Double click anywhere within the Curve Fill or layer to
activate the Curve Fill Options window
3.) Click on the
button. This will
activate a list of curves associated with this well.
4.) Click on the Drill Rate and then click on the
button or double click on the Drill
Rate Curve. You will now view the curve name below
the

button.

button. This will
5.) Click on the
activate a list of curves associated with this well.
6.) Click on the Total Gas Curve and then click on the
button or double click on the Total
Gas Curve. You will now view the curve name below
the

button.

Curve Options Portion of the Window. This information is
pertaining to the Main Curve and its Curve attributes.
7.) Click on the Pattern Type down arrow and select the
correct curve pattern for the main curve. The Drill Rate
Curve is defaulted to PtoP (Point to Point).
8.) Click on the Grid Type down arrow and select the correct curve grid type for the main curve. The Drill Rate
Curve is defaulted to Linear.
Fill Options Portion of the Window (2-Two Curves)
9.) Click on the Fill Modes – 2 Curve down arrow and select the Fill Right of Main.
10.) Click on the Fill Patterns down arrow and select solid foreground.
11.) Click on the Foreground Color down arrow and select yellow.
12.) Click on the
button. The Curve Fill Options window will close and the changes you have made will be
shown on the layer.
Layers Organizer
The Layers Organizer allows the user to set priority to the layers that are in a track. Also allows the user to
move a curves grid pattern up over top of others layers data. As you can see now the Curve fill takes
president over the curve grid pattern. You can only organize the one grid at a time.
1.
2.

Click on the Drilling Progress Track. It will highlight with a green outline.
Select the Drill Rate Curve layer form the Layer Selection List.
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Click on Layers Organizer, under the View menu selection, or click on the
Layers Organizer button on
the Toolbar to activate the Layers Organizer window for the Drilling Progress track.

The order of the layers on this list determines the order in which the layers are drawn on the track. The layer at the
top of the list is drawn last and the layer at the bottom is drawn first. It's a good idea to put the most important
layers nearest the top of the list, so that when drawn they are on the top. Remember that the active layer displays
its grid pattern.
The layers that are shown on the track are marked with a "Y", the hidden layers are marked with an "N", and the
active layer is denoted with a ">".
To show all layers, click on the

button. To hide all layers, click on the

specific layer between show and hide, highlight the layer and click on the

button. To toggle a
button. You may also double

click on a layer to change its current state. To make a layer active, highlight it and click on the

button.

Moving the Grid for an Active Curve layer…
4.

Highlight the Movable Grid (associated with the Drill Rate Curve because it
is the active layer) selection and click on the

5.

6.

button, which will

then display,
Click on the ROP/TG Curve Fill layer and the grid pattern will move above
and the Movable Grid selection will then move one line above the selected
layer.
Click on the

button to exit from the Layers Organizer window.

Note: You will have to repeat all the steps above to get the Movable grid associated with each curve above the
ROP/TG Curve Fill layer. The Layers Organizer will only save data on exit. So you must exit after each layers
moveable grid has been moved.
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*** Your Log should now look like the picture shown below***
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How to Print the Log to a Printer Driver.
1.) Under the File menu, click on Print Log or click on the Print
Log window.

button on the Toolbar to activate the Print

Note: The Title bar and all depths associated with the Print Log window are defaulted to the Depth View that
Power*Log is set to at the time of the activation of the Print Log window.

2.) Select the letter portrait (because your log is 8” wide) from the Page Orientation drop box field and the
Title Page, Legend, and Formation Tops will automatically conform to the selected orientation.
Note: The selection of letter, legal or tabloid (landscape or portrait) settings from within this Print Log window will
NOT override the paper orientation settings selected in the printer's Properties window. Therefore, you must also
modify the paper orientation settings in your Printer setup Properties window to select the corresponding paper
size and orientation.
3.) Activate the Dynamic Legend check box , if you wish to have the legend to reflect only the symbols printed
on the log or core portions of the printed intervals defined in the log and core portions of the print log window.

In the Log portion of the Print Log window
1.) Select 1:200 from the scale drop box for the log to be printed out at.
2.) Click to activate the Header and Footer check boxes to print the track headers / footers on the log.
3.) Click on Lithology Section to highlight it in the printing options selection box.
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Note: The log itself must be displayed in whatever depth view you wish to print before you activate the print log
window. To change the log to the desired format refer to depth view under the view pull down menu.
Page Margin
The page margin field is available, primarily, when you are printing to Adobe Acrobat writer.
When a numerical value in inches is typed into this field it will initiate a top and left margin for the templates (Title
Page, Legend and Formation Tops) as well as a left margin for the main log.
Page Overlap Activate the Page Overlap check box if you are printing on single sheets. This will force the
printer to include an additional 1/4 inch of the log at the top and bottom of each page, so that you can cut-and-paste
pages manually, if you so desire.
Print Methods…
Default Activating the Default radio button forces Power*Log / Curve / Core to use a raster or bitmap graphic
printing method. This printing method is generally used with Laser printers but not exclusively so.
Meta File
Activating the Meta File radio button forces Power*Log / Curve / Core to use the meta file
technology printing method. This printing method was developed for the newer models of printers on the market
today as well as using the Adobe Acrobat Distiller or pdf printing technology.
Color Options…
Auto
Activating the Auto radio button forces Power*Log / Curve / Core to use the settings from the printer
driver to printout the log.
Color Activating the Color radio button forces Power*Log / Curve / Core to override the printer driver settings
and consequently Power*Log / Curve / Core assumes that you are using a color printer.
Mono Activating the Mono radio button forces Power*Log / Curve / Core to override the printer driver settings
and consequently Power*Log / Curve / Core assumes that you are using a monochrome (black and white) printer.
Interval per page field indicates how many meters of log will fit on a page of selected paper size and orientation
selected in the setup as well as what log scale you are printing at. This will help indicate to the user how many
pages will be required by the print job.
1.) Click on the Core Section 6070-6106 Core 1 to highlight it.
2.) Select the Core log scale of 1:96 and the Core Track Header and Footer check boxes .
3.) Click on the
are in effect.

button to activate the Print Setup window and confirm that the correct printer settings

Note: If you are printing out logs in color, you must activate the Diffusion or Error Diffusion option normally
found under Graphics in the Properties window for most printers.
4.) When you are ready to print your log, click on the
button.
Note: If you do exit from the Print Log window, you will be asked if you wish to save the print settings. If you click
on Yes, the program will remember every setting that you made to the Print Log window and then will default to
those settings the next time you enter the Print Log window.
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How to Print the Log to a TIFF (file format)
Prints all or part of your log/well along with the Title page, location map, legends, survey views,
individualized cores and formation tops on a continuous basis in a tiff file format.
1.

Under the File menu selection, click on Print to TIFF or click on the
to activate the Print to TIFF window shown below:

Print to TIFF button on the Toolbar

Note: The depth views associated with the Print TIFF window are defaulted to the Depth View that Power*Log /
Curve / Core is in at the time of the activation of the Print to TIFF window.

2.
3.
4.
5.

Select letter Portrait from the drop box field for the Title Page,
Legend, Tops, Survey Views and they will automatically conform to the selected orientation. There are four
(6) types of paper orientation to choose from. But your log is 8” wide so letter portrait is the page orientation.
Select this check box , to printout a Title Page.
The Type (Title Page) drop box displayed on the right allow you to pick the appropriate title
page format to print. Select standard to prints out our full blown title page with most of the
Wells data.
Select the AER UWI format for the Title page as the well is in Alberta.

N.B. This format changes our UWI printout from 100121605812W500 to 00/12-16-058-12W5/0 only on the Striplog
Title page. All other UWI formats (DLS and NAME) remain the same.
6.

Activate this check box
drop box field.

, if you wish to printout a logo, and then select a logo from the Logo

Note: The logo file format must be a bitmap image file (*.bmp) if you want a logo printed out on the title page. Also,
it is recommended that the bitmap image should be a square image, because Power*Suite will shrink or expand
the image to fit the logo space on the Title Page. This bitmap must be placed in the Powersuite_2015\logo
directory for the application to find it.
7.

Type any pertinent comments into the Title Page Remarks field and they will be displayed accordingly on the
Strip Log Title Page only.

8.

Deselect the
check box. In our Case we do not have a
location map so deactivate this check box . If you wish to printout a location map following the title page, and
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then the user select a location map from your computers drives by clicking on the
want to print out as a location map.

and finding the file you

Note: The location map file format must be a bitmap image file (*.bmp) if you want a location map to be printed
out. Also, the bitmap image must be a square image, because Power*Suite will shrink or expand the image to fit
the location map space following the Title Page. This bitmap can be placed anywhere as the file location is saved
within the Power*Suite initialization file. (pgeology.ini)
9.
10.
11.
12.
13.
14.
15.

Deselect the Survey views
check box.
Deselect the Survey views
check box.
Deselect the Survey views
check box.
Deselect the Survey views
check box.
Deselect the Survey
check box.
Select the
to activate this check box .
Select the
to activate this check box , because we want the legend reflect only the symbols
printed on the log or core portions of the printed intervals defined in the log and core portions of the print log
window.

In the Log portion of the Print Log window
16.

Select 1:200 or type in the
Scale for the main log to be printed out at, in
the Scale drop box field.

17. Select
to activate this
check box to have the track headers
/footers printed out with the main log.
18. Select
to activate this check
box to have the core accessories printed out on the main log.
19. Select the defined interval. Type in 5995 and 6112 in the from and to fields.
Note: The log itself must be displayed in whatever depth view you wish to print before you activate the print log
window. To change the log to the desired format, refer to depth view under the view pull down menu.
In the Cores portion of the Print Log Window
20. Highlight Core 1 highlighting them.
21. Select 1:96 or type in the Scale for the core
log to be printed out at in the Scale drop box
field.
22.
Activate this check box
to have the track headers / footers printed out
with the core log.
Note: A separate Header Information Box is automatically printed out with every Core and includes the Core
Scale, Core Date, Core Number, Cored Interval, Amount Cut, Amount Recovered, and Percentage.
23.

Activate this check box if you wish to printout Formation Tops and the Formation Tops will be
included on a separate page at the end of the log printout.

The page margin field is available, primarily, when you are printing to Adobe Acrobat writer. This is
not necessary for printing to tiff file format
24. When you are ready to print your log, click on the

button.

25. This will activate a message box indicating the size of your printout. Click on the
button.
26. This will activate a file name window to be filled in with a file name and location to where
you can locate it for further reference.
Note: If you do exit from the Print to TIFF window, you will be asked if you wish to save the print settings. If
you click on Yes, the program will remember every setting that you made to the Print to TIFF window and then
will default to those settings the next time you enter the Print to TIFF window
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Adding a Link (Attachment) to your Log
1.) In our case Right Click on the Lithology Description layer to activate the pop out menu.

2.) Select Add / Edit / Open Link from the pop out menu. This will activate a blank Links window with the depth
you right clicked at.
3.) Click on the
button in the Links window and you can now pick any windows compatible file. In our
case I am linking the printed well file from the next section of the tutorial printed to my backup folder and then
button. This will fill in in the details of the File Name and location in this window.

click on the

4.) Now the user can Type in some remarks to tell the viewer what the file is (if the user would like to identify the
file) and then click on the

5.) Click on the
link the file to the log.

button. This will activate the Shortcut Options Window.

button. This will insert the paperclip symbol

where you originally right clicked and

This concludes the Power*Log Tutorial. If you need help with specific functions
or operations, please use the Table of Contents in the Power*Suite User Manual
to find the desired topic or use the Search function built into the On-line Help.
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